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1. Introduction 

 
Welcome! TamTamCRM is a Customer Relationship Management Application, which will enable you to proficiently 
manage, populate and update your customer relationship information. TamTamCRM will make your customer 
relationship activities more efficient, easily managed and organized. With TamTamCRM everyone can record all of 
their interactions with clients, keeping all co-workers well informed of the current state of issues, sales 
opportunities and scheduled activities. TamTamCRM offers multiple business information management on new 
business opportunities, sales leads, product listing, installation units, business contacts, numerous customer 
accounts and other business activities, such as assigned tasks scheduling, make calls and send meeting invitations. 
Considering the enormous functionalities, thanks to the user-friendly interface, TamTamCRM is easy to use 
software.  

By recording all new business activities with TamTamCRM, you can keep track of qualified leads and convert them 
in specific opportunities. Welcome on TamTamCRM board! We are making our way to a better business.  

2. ABOUT THIS GUIDE 

  
The TamTamCRM User Guide is intended for new users who are interested to leverage on the features and 
functionalities of TamTamCRM to increase productivity. This guide will lead you to the fundamental concepts and 
help you step-by-step to get comfortable with the application. With this guide, you will be able to perform 
extensive activities and implement some specific administration features which will be part of the TamTamCRM 
operation activities. 

3. TAMTAMCRM OVERVIEW 

 
TamTamCRM is a system that manages information and processes around your relationship with your customers, 
not only the marketing and sales aspects of that relationship but also the ongoing service and support aspects. 
TamTamCRM represents one of the best systems available in the market for the manner in which the system is 
navigated. The TamTamCRM navigation is simple and easy.  Just click the tab placed across the top to access 
specific function of, such as: 

 Home 

 Organizations 

 Product 

 Installation Unit 

 Cases 

 Activities 

 Contacts 

 Opportunities 

 Leads 

 Documents 

 Emails 

 Campaigns 

 Projects 
 
You will be able to handle your customer accounts through the business cycle with the modules listed above. The 
cycle would begin by producing and segmenting leads to scheduling day to day business activities and generating 
reports.  
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Most of the steps in the business cycle are connected, thus TamTamCRM has related sub-panels in each of the 
module, which would speed up and ease the navigation. When you open some activity, say, an account, you will 
see sub-tabs below the detail view of the activity. The sub-tabs contain links on various fields, clicking on which will 
take you to the, the related contact, or the related account, or other related feature. Besides, you can not only 
view and edit this information but also create new information.  

3.1. TamTamCRM’s Basic Functions 

Below are the basic functions of TamTamCRM: 

 Creating organizations, branches and contacts, and relating multiple contacts to a single organization and 
branches. 

 Creating product and installation units.  

 Creating project 

 Following links between related data. 

 Creating and tracking the Sales Pipeline from leads to opportunities to contacts and organizations. 

 Creating and monitoring sales activities and accumulating activity history. 

 Scheduling activities with colleagues by referring to their calendars. 
 

3.2. TamTamCRM’s Basic Features 

TamTamCRM is provided with a number of useful features which help manage information and processes around 
your relationship with your customers. Fundamental features include: 
 

 Sales-force automation: This includes lead capture and the promotion of leads to Opportunities. 

 Lead source analysis of sales and opportunities. 

 Document management and revision control: This helps in managing and retaining reference copies of 
important corporate documents.  

 Opportunity tracking: This tracks the sales stage and percentage likelihood. 

 Definition of sales teams and territories: This helps in managing information sharing and tracking sales 
performance by territory.  

 Shared calendar management: This can be used for arranging meetings. 

 Service case tracking: There are also other service/support capabilities such as tracking software bugs, and 
managing support contract renewals.  

 Flexible reporting: This extracts precisely the information you want to see.  

 Corporate directory: This can be used for contacting fellow employees.  

 Maintaining organization records separate from contact records. 

 Maintaining organization and contact history. 

 Integrated web-based email. 

 Interface consolidation: This includes news feeds, views of financial metrics, integration of external web links 
and applications.  

 

3.3.  Efficiently with TamTamCRM   

TamTamCRM’s powerful capabilities, if adopted and utilized right, will change the whole way you do business:  
 

 TamTamCRM’s new marketing communications capabilities will help increase sales.  

 Automatic sharing information with everyone instantly, necessity to type in information only once and 
common awareness of everyone in the business of where to find information help reduce costs. 

  Dealing with employees who now know more about what's going on in the customers’ organizations 
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increases the level of customers’ satisfaction.  

 Identification of most productive lead sources and conversion of perspective leads into opportunities, as well 
as better understanding of sales pipelines help manage all processes more efficiently.   

 
In order to take real advantage of the TamTamCRM, you need to know how to use it from the very initial steps. Full 
information about how to start working with TamTamCRM is given in the next chapters of this User Guide.  
 

4. GETTING STARTED WITH TAMTAMCRM  

 
The main focus of this chapter is how to prepare to work with TamTamCRM. The chapter will answer the question: 
“What will I need for successful implementation of my tasks with TamTamCRM?” 
 
Topics include: 
 

“Technical Requirements”  
“Accessing TamTamCRM ” 
  

4.1. Technical Requirements 

 

Before you begin using the system, ensure that you have the required software installed and configured on your 
system as follows: 

 A current Web browser on your computer. TamTamCRM has been successfully tested on the following 
browsers: 

Google Chrome 6.0 and higher 
Mozilla Firefox 2.0 and higher 
Microsoft Internet Explorer 7.0 and higher 
Safari 4.0 and higher 
Microsoft Internet Explorer 5.0 and higher 
Konqueror version 3.2 and higher 

 
You may encounter problems if you try to access TamTamCRM using older Web browser versions such as Internet 
Explorer 4 or Netscape 4.x. If you are unsure about which version you are using, click Help > About or similar 
options on the menu bar in your browser to display the version number. 
 

 Enable Java Script and cookie support on your Web browser. If you encounter problems accessing the system, 
check your browser configuration to ensure both Java Script support and cookie support are enabled as 
follows:  
- Internet Explorer: Click Tools > Internet Options > Privacy and Security tabs; 
- Firefox: Click Tools > Options > Privacy and Web Features tabs. 
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4.2. Accessing TamTamCRM  

You can access TamTamCRM through a Web browser. To enter the system, you need to log in. Enter the 
TamTamCRM URL in the address bar of your Web browser. The Login window displays. Enter your username and 
password, assigned to you by the system and administrator and click on Login: 
 

 
If login successful, your name will be displayed at the top right of the screen. You can click it to view and edit your 
default settings. You can also view the list of modules you are allowed to access, and your access permissions, such 
as View, Edit, and Delete, for each module.  

 

To View and Edit user profile: 

Click your name at the top right of the screen. You will redirect to the user profile tab. 

 

The User’s profile tab displays information such as full name, user name, phone number, address, title, and email 
address.   
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To Change the Password 

 Click Password tab. 

 In the Current Password field, enter your current password. 

 In the New Password field, enter your new password. 

 In Confirm Password field, enter your new password again. 

 Click Save to change the password. 
 

 

4.3. TamTamCRM Module Options 

The following options are available from any screen in the TamTamCRM application: 

 Global Search: This field allows users to enter a letter or a keyword to search all the modules for matching 
records. 

 System Links: This links, located at the top right-hand corner of the page, are common to all modules. 
These include your name, Logout, Employees, Support, and About. When an administrator logs in, the 

Admin link is also visible. 
o You Name: Click this link, located at the top right of the page, to view your settings. These 

settings include your profile information, layout options, and so on. 
o Employees: Click this link to view a list of other employees in your organization. This list, 

maintained by the administrator, displays information such as name, title, phone number, 
department, and email address. Click a name to view detailed information about the employee. 
Every user is listed as an employee.  

o Admin: This link displays only if you log in as the administrator. Click this link to access the 
Administration Home page to perform administrative tasks. 

o Support: Click this link to view the TamTamCRM Support page, which provides links to 
TamTamCRM documentation and FAQs to guide you through the process of learning the 
TamTamCRM application. 

o About: Click this link to learn more about TamTamCRM and view version information.  

 Last Viewed: This list displays records that you last accessed within the module, as well as calls and 
meeting you recently scheduled.  
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4.4. Viewing and Managing Record Information 

 
Every module represents a record type such as organizations, opportunities etc. TamTamCRM provides three types 
of views for every module: a list view, a detail view, and an edit view. Let’s have a look at each of these 
separately.  
 
 
List view: The list view displays links to individual records in table format. The list view also displays other relevant 
information such organizations, dates etc for each record: 
 

  
 
Detail view: To drill down to the record’s detail information, just click a record name. You can also click the view 
icon to navigate to the detail view and the Edit icon to navigate to the edit view, if you have edit permissions. The 
detail view displays the detail page with all the available information for a record such as name, modified date, and 
related records. The related records are displayed in the appropriate sub-panels. The detail page provides four 
options which is edit, delete, and duplicate record information. Similarly, you can edit and delete records in sub-
panels. You can also create a new record or select one from the existing list: 
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Edit view: The edit view allows you to revise the information that you viewed in the detail view. 
 

 

4.4.1. To View and Edit Record Information 

 
Click the record name on the list to view its details. Then click the Edit button on the top of the page if you want to 
edit the record: 
 

 
 

4.4.2. To Manage Related Information in Sub-Panels 

 
The detail page displays also related information in sub-panels. For example, the detail page of an opportunity 
display sub-panels for related activities, contacts, leads and so on. Each sub-panel consists of rows to list multiple 
records: 
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You can add more records to the list by clicking Create above the sub-panel; adjusting the necessary fields and 
clicking Save above the sub-panel. (If you need to fill in the full information for the record, click the Full Form 
button): 
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To edit or remove a record, click the corresponding edit or rem icon respectively: 
  

 
 
To minimize a sub-panel, click the arrow icon that is located next to its name: 

   
 
That will make all records under this sub-panel invisible. 
 
To move a sub-panel to a different location on the page, place the cursor on the arrow icon, hold down the cursor, 
drag the panel to the new location and release the cursor. 
 

4.4.3. Tracking and Managing Record History 

 
The detail page of every record displays a History sub-panel that enables you to track record-related activities such 
as meetings, notes, attachments, and archived emails. Each row in the panel displays icons to edit or remove the 
record. You can also use this sub-panel to create and record new activities. 
 
To track and manage record history 
 
1. To view the details of a listed note, meeting, attachment, or email, click the Subject title. 
2. To view a summary of all the listed records in a separate window, click View Summary. 
3. To edit or delete a record, click the appropriate edit or rem icon respectively. 
4. To archive an email related to the record, click Archive Email.  
 

4.5. Managing TamTamCRM Dashlets 

 
Dashlets are user-configurable panels on the Home page that allow you to specify the items that you want to view 
on your home page. A dashlet displays a list of item records that is similar to the list view displayed on a module’s 
home page. TamTamCRM displays a collection of dashlets for items such as meetings, activities, and Organizations 
on your home page. On the picture below, the dashlets on our TamTamCRM’s home page are outlined with red 
color.  
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You can configure each dashlet to display the rows, columns, and filters that you need. For example, you can 
change a dashlet’s title or choose to view only your items. You change the number of rows to be displayed and 
select what rows need to be displayed and what need to be hidden with the help of special arrow buttons on the 
edit form.  
 
To edit a dashlet 
 

1. Click on the Edit icon in the top right corner of the dashlet’s panel: 
 

 
2. Implement the necessary changes to the edit form which will drop down as you click the Edit icon and 

click Save: 
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To add a dashlet 
 

1. On the Home module, click Add Dashlets: 
 

 
2. The available dashlets display on the left: 
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Click a dashlet name to add it to your home page. Each time you click the name, a new dashlet is added on the 
page. 
 
To manage dashlets 
1. To move a dashlet, place the cursor on its title, press and hold down the mouse button and move it to the new 
location, and then release the mouse. 
2. To delete a dashlet, click the Delete icon. When the system displays a message confirmation, click OK to confirm 
its removal: 
 

 
 
3. To refresh a dashlet, click the Refresh icon: 
 

 
 
Note: If you cannot add or move dashlets, check with the administrator to ensure that the functionality has been 
enabled. 

4.6. Merging Duplicate Records 

Use this function to merge duplicate records into single records to update and clean up the data. You can merge 
records in the following modules: Organizations or Accounts, Contacts, Leads, Opportunities and Cases. 
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To merge duplicate records from the list view: 

1. On the module’s home page, select the duplicate records and click the Merge Duplicates or Find 
Duplicates tab: 

 
The Merge Records page displays 2 different fields. One is from primary record placed on the left side and 
another field from the duplicate records placed on the right side. Click the << button to choose required 
fields from the duplicate data to be replaced with the primary data. Any fields that have different data will 
be displayed beside the << button. 

 To indicate the duplicate records as the primary, click Set as Primary above the duplicate fields. 
The system will exchange position for both records.  

 To substitute any required field in the primary record with a field from a duplicate record, click 
the << button. The system will change the data in primary record to the data from the duplicate 
record. 

 
2. Click Save Merge. 

 
To merge duplicate records from the detail view: 

 
1. The first step of finding duplicates display on the screen. You will have to set filters to specify the field 

that you want to search for. For example, you can search for records that have the same billing address or 
phone number. 

2. Select one or more filters and click Next Step; to remove a filter, click the Trash icon located next to the 
field name. 

3. The search results display all the records that contain duplicate information for the specified field. 
4. To view the details of a record, click its name in the search results. 
5. Select the records that you want to merge and click Perform Merge. 
6. The Merge Records page displays on the screen. 
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Below is the example of the Merge Records page: 
 

 
 

3. Click Save Merge to merge record, all related information will be moved to the primary record, and the 
duplicate records will be deleted. 

 

4.7. Searching for Information on TamTamCRM  

 
You can perform the following types of searches in TamTamCRM: 
 

“Global Search” 
“Basic Search” 
“Advanced Search” 

 
Below we shall look more closely at each type of search. 

4.7.1. Global Search 

You can perform a global keyword search at the system level for text that matches the beginning of key field 
names. Our database configuration makes global searches not case-sensitive. To perform a global search, enter the 
keyword in the Search field and click Search: 
 

 
 
If you do like this, the system will search Organizations, Contacts, Leads, Opportunities, Cases, and Projects and 
display search results for each of these modules.  
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The module with the most records displays at the top of the search results page: 

 
 

4.7.2. Basic Search 

 
You can perform a basic keyword search within most modules. To perform a basic search, in the Search sub-panel 
on the module’s home page, enter values for one or more fields and click Search. To find only records that are 
related to your tasks and activities, select the only “My Items” box: 
 

 
 
The search fields are context-sensitive and vary depending upon the module you are searching. When you type a 
character in a field, the system performs a quick search of possible values and presents a list of values starting with 
that character. Typing additional characters restricts the resulting list. 
These rules are also applicable to advanced search. You can edit or delete records in the search results.  

4.7.3. Advanced Search 

 
To further filter the search results, click the Advanced Search link. The system displays additional fields that vary 
depending on the module you select: 

 

 
 
In this chapter, we have made our initial steps around TamTamCRM navigation and functionality. Read the next 
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chapter of this User Guide to find out exactly how to use TamTamCRM modules. Using TamTamCRM Modules 
 
In the previous section of this User Guide, we have looked at the basic concepts of TamTamCRM functioning.  
Now, we can move on to a more detailed view of the TamTamCRM modules, which are the most functional part of 
TamTamCRM’s interface.  
 
Topics include: 
     

“Home Module” 
“Organization Module” 
“Products Module” 
“Installations Units Module” 
“Cases Module” 
“Activities Module”    
 “Contacts Module”                                 
“Opportunities Module”                 
“Leads Module”                  
 “Documents Module” 
 “Emails Module” 
“Campaigns Module” 
“Projects Module” 

 

4.8. Home Module 

 

When you login into the TamTamCRM, the Home module will be displayed on the screen. The tabs for other 
modules display alongside the Home module tab. By default, the Home page displays the dashlets listed below. 
You can remove the ones that you do not need and add other dashlets. 
 

- Discover TamTamCRM - Displays TamTamCRM web site. 
- My Top Open Opportunities - Lists the opportunities that you share with other team members; 
- My Leads - Lists the leads that you share with other team members; 
- My Contacts – Lists contacts that you share with other team members; 
- My Organizations – Displays organizations assigned to you by yourself or other users and shared with 
other team members; 
- My Feed - The TamTamCRM Feed dashlet on your Home page enables users to notify each other 
immediately when one of you creates a new contact, lead, opportunity, or case. Users are also notified 
when a lead is converted and when a case or opportunity is closed. Additionally, the User Feed enables you 
to post your status along with external links, images, and YouTube videos; 
- TamTamCRM News – Displays TamTamCRM news; 
- My Meetings - Displays meeting invitations including the subject of the call, the duration, and the start 
date; 
- My Calls - Lists the calls that you have to make assigned to you by yourself or other users; 
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4.8.1. Managing Chart 

Use the Dashlets to view and manage charts based on custom and predefined reports. A chart is a graphical display 
of report output: 
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Customizing Predefined Charts 
 
To enhance performance, the system does not automatically recalculated chart data each time you click the 

Dashboard tab. To recalculate the data source, click Refresh button above the chart. 
 
You cannot delete predefined charts but you can edit them to suit your requirements.  
TamTamCRM provides the following predefined charts: 
 

- All Opportunities by Lead Source. A pie chart of that displays the proportion of total sales opportunities 
for each lead source. 

- All Opportunities by Lead Source by Outcome. This bar chart displays total opportunities for each lead 
source.  

- Outcome by Month. This bar chart displays the total sales pipeline for each month.  
- Campaign ROI. Displays a campaign’s return on investment. 
- My Pipeline by Sales Stage. A horizontal stacked bar chat that displays total opportunities for each sales 

stage. Each bar is made up of multi-colored segments which represent the outcome. 
- Pipeline by Sales Stage: This horizontal bar chart displays the total ringgit or dollar amounts for all 

opportunities grouped by sales stage. 
 
To customize a predefined chart 
 
1.  On the Home Module, click the Edit icon on the top right corner of the chart.  
A dialog box displays the details of the report on which the chart is based: 
 

 
 

 
 
2.  Edit the details as necessary and click Submit. The chart reflects the changes to the report. 
 
To manage charts 
 

- To ensure that the chart is displaying the latest data, click the Refresh icon at the top right-hand corner of 
the chart.  
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- To change the order in which the charts are displayed, click the down arrow on the Dashboard tab and 
select Change Layout. Alternatively, select the chart title and drag and drop the chart at the desired 
location. 

- To remove a chart from the dashboard, click the Delete icon at the top right-hand corner of the chart. 
- To add a chart back on the dashboard, click Add Dashlet. The Add Dashlet window displays the list of pre-

defined charts. 
- To copy a chart for inclusion in a document, take a screen copy (such as by using Alt-PrtScn on Windows) 

and then crop the captured image in an image editor such as Photoshop.  

4.9. Organizations Module 

Use this Organizations module to create and manage customer organizations for your organization. Previous name 
of Organizations Module is Accounts Module. The rename is done because it’s easy for the user to identify the 
organization.  
   

 
 
Every organization contains customer information such as name and address. Each organization can be associated 
with other records such as opportunities, activities, leads, installation units, products and contacts. 
  
The Action bar displays the following options: 
Create Organization, View Organizations, Import Organizations, Create Branch and View Branches  

4.9.1. To Create an Organization 

1. In the Action bar, click Create Organizations.  
2. On the Organizations page, enter the following information: 

 Organization Name. Enter a name for the organization. 

 Website. Enter the URL for the organization’s Web site. 

 Office Phone. Enter the phone number of the organization. 

 Fax. Enter the fax number for the organization. 

 Address Information. Enter the primary address and other address information. To copy the other 
address from the primary address, select the Copy address from left checkbox. 

 Email Address. Enter an emails address for the organization and your contacts and campaign 
targets within the organization. If an email address is incorrect, select Invalid to indicate it.  

 To add an additional email address, click Add Address. You can add multiple email addresses. 

 Description: Enter a description for the lead.  
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 Type. Enter the organization category. 

 Annual Revenue. Enter the annual revenue. 

 SIC Code. Enter the Standard Industrial Classification code that indicates your organization’s type 
of business. 

 Member of. Enter the names of organization associated with the organization. 

 Campaign. Enter a campaign address for the organization. 

 Industry. From the drop-down list, select the industrial sector to which the organization belongs. 

 Employees. Enter the number of employees in the organization. 

 Ticker Symbol. Enter the stock ticker symbol for the organization. 

 Ownership. Specify the owner information. 

 Rating. Enter the organization’s rating in the industry.  

 Assigned to. Enter the name of the individual who is responsible for communicating with the lead. 
To choose an existing user, click Select, and choose the person from the User List. By default, this is 
assigned to you. 
 

See an example of the completed “Create Organization” form below: 
 

 
 

3. Click Save to save the new Organization information; click Cancel to exit the page without saving the 
information. 

 

4.9.2. To Create a Branch 

In the Action bar, click Create Branches. Optionally, you can use the “Create Organization” quick form. 
On the Organizations page, enter the following information: 

 Name. Enter a name for the organization. 

 Office Phone. Enter the phone number of the organization. 

 Website. Enter the URL for the organization’s Web site. 

 Industry. From the drop-down list, select the industrial sector to which the organization belongs. 

 Employees. Enter the number of employees in the organization. 
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 Ticker Symbol. Enter the stock ticker symbol for the organization. 

 Ownership. Specify the owner information. 

 Rating. Enter the organization’s rating in the industry. 

 Alternate Phone. Enter alternate phone number of the organization. 

 Fax. Enter the fax number for the organization. 

 Type. Enter the organization category such as Customer or Partner. 

 Annual Revenue. Enter the annual revenue for the organization. 

 User. Enter the name of the individual who is responsible for communicating with the lead. To 
choose an existing user, click Select, and choose the person from the User List. By default, this is 
assigned to you. 

 Organization. Enter the names of organization associated with the organization. 

 Address Information. Enter the primary address and other address information. To copy the other 
address from the primary address, select the Copy address from left checkbox. 

 Email Address. Enter an emails address for the organization and your contacts and campaign 
targets within the organization. If an email address is incorrect, select Invalid to indicate it. If you 
sent out campaign emails this contact and the individual chose to opt-out of receiving them, select 
Opted Out. 

o To add an additional email address, click Add Address. You can add multiple email 
addresses. 

 Description: Enter a brief description for the lead.  
See an example of the completed “Create Branches” form below: 

 

4.9.3. To View and Manage Organizations 

- To sort the organizations list, click the   icon beside it; to reverse the sort order, click the column title 
again.  

- To edit or delete all or some organizations on the list, select any organization and click delete from action 
drop down list. 
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- To view the details of an organization, click its name in the list. The detail page will displays sub-panels for 
related records such as Activities, History, Contacts, Opportunities, and Leads. You can create new records 
or edit existing ones.  

- To export records, check appropriate organizations, click Action -> Export and follow the process 
described in “Exporting Data”. 

- To import records, select Import from the Action bar. 
- To merge duplicates, click the Merge Duplicates link and follow the process described in “Merging 

Duplicate Records”. 
- To edit an organization, click Edit, make the changes, and click Save. 
- To duplicate an organization, on the detail page, click Duplicate, and click Save. The system duplicates the 

organization and displays its detail page. Duplication is a convenient way of creating a similar 
organization. You can change the information in the duplicate record to create a new organization. 

- To delete the organization, on the detail page, click Delete. 
- Click View Change Log to track changes to organization information. 
- To view or manage related records in a sub-panel, see “To manage related information in sub-panels”. 

4.10. Products Module 

 

This module is to record the Products installed or purchased by any organization. This module will give you the 
records that which product is on more demand in the market and Service team can use this module to register or 
log an issue against any Product. 
 
To create a product: 
 

1. In the Action bar, click Create Products.  
2. The system will respond with the form to fill in. The fields to fill in include:  

 Name. Enter the name of the product you are using to create the product. 

 User. Select user of the product. By default, the user is you. 

 Description. Enter a brief description of the product. 
3. Click Save to create the product; click Cancel to return to the product list without saving the product. 

Look at the example of filled in “Create Product” form below: 

 
 
After you save the product, the product’s detail page displays on the screen. You can create activities, history, 
Installation units, Cases and organization.  
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To manage product 

- To export records, check off the appropriate product and click Action ->Select Export.  
- To merge duplicates, check off the appropriate products and click Action ->Select Merge. 
- To find duplicates a product, on the detail page, clicks Find Duplicates. 
- To track changes to the product information over time, click the View Change Log link.  
- To edit or delete information some or all of the products, check off appropriate products, click Action -> 

Delete. 
- To view detail information, click on the product name list.  
- To edit information, on the detail page, click Edit. 
- To duplicate a product, on the detail page, click Duplicate 
- To delete a product, on the detail page, click Delete. 

 

4.11. Installation Units Module  

This module will use in recording the particular product that has been sold to a particular Organization’s Branch. 
For identification of the products each and every Product’s Serial Number will be recorded here. 
 

To create an Installation Unit: 
 

1. In the Action bar, click Create Installation Units.  
2. The system will respond with the form to fill in. The fields to fill in include:  

 Serial No. Enter the serial number of the unit you are using to create the installation unit. 

 Products.  From the drop-down list, select the related product. 

 Organizations. From the drop-down list, select the particular organization. 

 Installation Site. Enter the installation site of the unit. 

 Term Period. Enter the term period of the unit. 

 Date of Installation. Select date of the installation unit 

 Branches. Select the branches of the installation unit. 

 User. Select user of the product. By default, the user is you. 

 Description. Enter a brief description of the unit. 
3. Click Save to create the unit; click Cancel to return to the installation unit list without saving the unit. 

Look at the example of filled in “Create Installation Units” form below: 
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After you save the units, the unit’s detail page displays on the screen. You can create activities, history, 
organizations and Cases. 
 

  
 
To manage installation units 

- To export records, check off the appropriate units and click Action ->Select Export.  
- To merge duplicates, check off the appropriate units and click Action ->Select Merge. 
- To track changes to the unit’s information over time, click the View Change Log link.  
- To edit or delete information some or all of the units, check off appropriate units, click Action -> Delete. 
- To view detail information, click on the unit name the list.  
- To edit information, on the detail page, click Edit. 
- To duplicate a unit, on the detail page, click Duplicate 
- To delete a unit, on the detail page, click Delete. 
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4.12. Cases Module 

 
Use the Cases Module to create, view, manage and import cases into TamTamCRM database as a comma 
delimited, tab-delimited, or custom delimited file. To import cases, select Import from the Action bar. 
 
To create cases: 
1. In the Action bar, click Create Case.  
2. The system will respond with the form to fill in. The fields to fill in include: 

 Number. Enter the number of the cases 

 Priority. From the drop-down list, specify the urgency of the problem.  

 Status. From the drop-down list, select the status to indicate the current state of the cases such as Draft 
or Under Review. 

 Type. Select categorize of the cases 

 Subject. Enter a statement of the problem. 

 Organizations. Select the organization of the cases 

 Branches. Select the branches of the cases  

 Products. Select the products of the cases 

 Resolutions. Enter the results of the investigations into the problem.  

 Descriptions. Enter a clear description of the problem 

 Assigned. Enter the name of the individual you want to assign to the record 
3. Click Save to create the case; click Cancel to return to the cases list without saving the case. 
4. Look at the example of filled in “Create Cases” form below 

 

To manage cases 
 
1. To edit or delete some or all cases, select any cases and click delete from action drop down list. 
2. To view the details of a case, click on the case name in the list. 
3. To edit the case details, click Edit, make the changes and click Save. 
4. To import records, select Import from the Actions bar on the Cases tab. 

5. To export information on one or more cases, select any Case List on the Cases Home page, click the 

Export from the action drop down list. 
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6. To merge duplicates, click the Merge Duplicates link. 

7. To duplicate a case, click Duplicate on the detail page.  

8. To find duplicates, click Find Duplicates on the detail page. 
9. To delete a case, click Delete on the detail page. 
10. To track changes to the case over time, click the View Change Log link. 
 

4.13. Activities Module 

 

An activity can be any interaction with colleagues and customers such as a phone call, a meeting, or an email. Use 
the Activities module to schedule and manage calls, meetings and tasks: 
 

 
 
 
Basically, the activity is related to a record such as an organization or contact.  You can schedule a meeting with 
one or more contacts to discuss a specific organization or opportunity. When you create the activity, you can 
specify the record to which it is related. This allows you to view the scheduled activities from the specified record.  
 
The Action bar displays the following options: 
 

 Log Call. Click this function to schedule a call as described in “Scheduling Calls and Meetings”. 

 Schedule Meeting. Click this function to schedule a meeting as described in “Scheduling Calls and 
Meetings”. 

 Create Task. Click this function to create a task as described in “Creating Tasks”. 

 Create Note or Attachment. Click this function to create a note or an attachment for a call, a meeting, or 
a task as described in “Creating Notes and Attachments”. 

 View Calls. Click this function to view and manage calls. 

 View Meetings. Click this function to view and manage meetings. 

 View Tasks. Click this function to view and manage tasks. 

 View Notes. Click this function to create or view notes. 

 View Calendar. Click this option to view your daily appointments in the calendar 

 Import Calls. Click this option to import your calls. 
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 Import Meetings. Click this option to import your meeting 

 Import Tasks. Click this option to import your task 

 Import Notes. Click this option to import external data into a note as described in “Importing Data”. 
 

4.13.1. Scheduling Calls and Meetings 

 
The Main purpose of this function is to schedule meeting and call. You also can put subject of discussion, the 
participants, the time period, and the status of the meeting or call you want to create. You can invite the 
participants immediately or at a later date to attend the meeting. In addition, any notes or attachments can be 
created at anytime. You can change the status of the record anytime for instance if you have to cancel it for any 
reason. The Calls page or the Meetings page shows the following sub-panels during creating a call or meeting: 

1) Scheduling. This function displays details such as the name of the attendees, the day, and the 
time of the call or meeting. If other calls or meetings are scheduled, the busy time is blocked out. 

2) Add Invitees. Use the Add Invitees sub-panel to find users that you want to invite as described in 
“To add invitees”. 

 
To schedule a call or a meeting 
 

1. In the Actions bar of the Activities Home page, click Log Call or Schedule Meeting.  
2. Put in any related data in the following fields: 

 Subject. Key in the topic of the conversation. 

 Status. Choose one of the following status from the drop-down lists provided: 
o Planned. Select this option if the call or meeting is approaching. 
o Held. Adjust the status from Planned to Held after accomplish the call or meeting. 
o Not Held. Change the status from Planned to Not Held if the call or meeting is cancel for 

any reason. 

 Start Date and Time. Click the Calendar icon and select the date; from the adjoining drop-down 
lists, select the time (hours and minutes). 

 Assigned to. Specify the user who is responsible for the call or meeting. By default, it is allocate to 
the user himself/herself. To assign to other user, click Select to view the list of users, and click the 
desired user name. 

 Duration. Key in number of hours and choose the number of minutes required into the prepared 
box and from the drop-down list respectively. 

 Related To. Optionally, enter the name of the related organization or click Select to search for one. 
Instead of an organization, you can choose another related record such as an opportunity or 
contact from the drop-down list. 

 Reminder. Select this box if you want the system to send out a reminder to everybody on the list 
prior to the call or meeting. Select a time for the remainder from the drop-down list below. 

 Description. Enter a brief explanation such as the rationale of the call or meeting. 
3. Click Save to save the call information; click Cancel to return to the Calls home page or Meetings home 

page without saving the information: 
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See an example of the completed “Schedule Call” form below: 
 

 
 

4. Click Send Invites to send out an invitation to the participants. 
5. To close the page and create a new call or meeting, click Close and Create New. 

 

To add invitees 

 
1. Enter desired information from the list below in the Add Invitees sub-panel: 

First Name. You can add an alphabet, a full name, or a partial name. 
Last Name. You can add an alphabet, a full name, or a partial name. 
Email. You can add an alphabet, a full email address, or just a fractional email address. 

2. Click Search. List of results will appear below with Add adjacent to each name on the list. 
3. You can send invitation to many users by clicking the Add button beside their names. See below: 
 

 
 
Now, in the Scheduling tab, along with you, if you are assigned to this activity, you will see the person who you 
invited to participate as well. To delete one of the participants, click Del: 
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4.13.2. Creating Tasks 

 
Any tasks created can be assigned to yourself or to other users based on the job related. The task also can be 
linking to a specific record such as an organization or an opportunity. You can also change the task status and keep 
it up-to-date. 
 
To create a task 
 
1. In the Action bar of the Activities Home page, click Create Task 
2. Enter following information in the specified fields as displayed in Task page: 

 Subject. Enter the focus of the task. 

 Start Date. Optionally, pick the start date for the task by clicking the calendar image; enter the time in the 
adjoining box. Choose None box if the task is not related to any date. 

 Due Date. Pick the end date for the task by clicking the calendar image; enter the time in the adjoining 
box. Choose None box if the task is not related to any due date. Enter the dateline information if you 
want to add the task on your calendar and subsequently receive a reminder when it is due. 

 Priority. Choose a priority that reflects the importance of completing the task from the drop-down list. 

 Status. Choose the current status of the task, such as Not Started, In Progress, and Completed from the 
drop-down list provided. 

 Related To. Choose any related module with the task from the drop-down list. For instance, say an 
organization and then click Select to search related organization.  

 Contact Name. Click Select to select a specific individual who is the contact for the task. By default, it is 
assigned to you. 

 Resolution. Select the task resolution. 

 Meeting. Select the task meeting 

 Note. Select the task note 

 Description. Key in a brief explanation of the task. 

 Work Log. Enter the work log for these task 

 Assigned to. By default, it is allocate to the user himself/herself. To assign to other user, click Select to 
view the list of users, and then click the desired user name. 

 3. Click Save to create the task; click Cancel to exit the page without creating the task. 
See an example of the completed “Create task” form below: 
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4.13.3. Creating Notes and Attachments 

 

TamtamCRM also allows you to create or import notes connected to a specific call, meeting, or task for sharing to 
participants. Notes enable you to add comments on a subject and maintain a record of discussions pertaining to a 
call, meeting, or task and attach any supporting documents to the note. 
 
To create a note or attachment 
1. In the Action bar, click Create Note or Add Attachment. 
2. Enter information for the following fields as appeared in the Note’s page: 

Contact. Put in the name of the contact by click Select to choose one from the Contacts list  
Related To. Optionally, enter the name of the related organization or click Select to search for one. Instead 
of an organization, you can choose another related record such as an opportunity or contact from the drop-
down list. 
Note Subject. Key in the matter of the note. 
Attachment. Click Browse to attach a document that is located on your computer, navigate it to the 
location of the file, and then select the file. 
Note. Enter the brief description of the note in this box. 

3. Click Save to produce the note or attachment or click Cancel to go back to the Notes home page without saving 
your changes. 
See an example of the completed “Create Note or attachment” form below: 



  
Title: TamTamCRM User Manual 

 
 
 
 

Confidential 

   

 

 

 Page: 34/77 

© TAMTAMCRM, 2012 
 

 

 

4.13.4. Using Calendar 

 

Use the Calendar module to view and to create activities such as appointments, calls, meetings, and tasks. To view 
your calendar by day, week, month or year, as well as to view your shared calendar, click the Activity Module at 
the top of the main screen: 
 

 
 
 
In each format, any planned activities with associated dates are displayed – such as Calls, Meetings, Tasks, Notes 
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and Emails. Icons are used to indicate the type of activity:  

 for a call; 

 for a task; 

 For a meeting. 
 

This system enables you to click on any activity on your calendar to update the information and move backwards 
and forwards in the calendar- by one day, week, month or year. You also can click on any date in the week, month 
or year format to view it in day format  
 
You also can create a related note or attachment to the call or meeting. For instance, you can use note to 
summarize the outcome of a call or a meeting. 
Other activities related to a call or a meeting includes creating a task and archiving emails. For more information, 
see “Activities Module”. 
 
The calendar record the hours of the day in Day format vertically. Click on a specific time to schedule a call or a 
meeting at that time, decide what you want to schedule – a call or a meeting – enter the subject name and click on 
Save: 
 

 
 
Optionally, you can create an appointment using the Create Appointment form, which allows you to quickly 
schedule a call or a meeting. This form only displays the required fields. You can add information for fields after 
you save the form.  
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4.13.5. To Create an Appointment 

1. In the Create Appointment form, select Schedule Call or Schedule Meeting.  
2. Enter the subject of the call or meeting 
3. Click the Calendar icon and select the scheduled date; enter the time in the Start Time field below. 

 Click Save: 

 
 
The Calls detail page or the Meeting detail page displays the information that you entered. 
 
Alternatively, for creating an appointment, you can use the Schedule Call and Schedule Meeting options in the 
shortcut section as described in “Scheduling Calls or Meetings”. 
 
A list of existing tasks displays on the right side of the main calendar body. To view the details of a task, click its 
subject title. From the detail view page you can Edit, Duplicate, Delete or Close and Create New call or a meeting: 
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4.13.6. Shared Calendar 

 
Now, the Calendar Module allows you to share your calendar with other employees. Thanks to the special 
“Shared” tab on the Calendar, this option is enabled.  
 

 
 
The Shared calendar option allows you to see the calendar of other users, and show them your calendar activities 
planned for a month. You can share the calendar with another user and both of you can see each other activities. 
Optionally, another user can share his/her calendar with you, but you don’t share yours. Click on “Edit” and select 
users for calendar display: 
 
Now, on your calendar, you can see a list of activities visible to you and to those with whom you are sharing your 
calendar: 
 

 

 

4.14. Contacts Module 

Apply the Contacts module to create and monitor contacts for your organization: 

 
 
A contact is the result of the conversion of valid sales lead; which means any individual that has been evaluated 
and reviewed for a possible sales opportunity. You can relate a contact with any record available such as an 
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organization, opportunity, or campaign. Relating a contact with a campaign enables you to track the success of the 
campaign in generating opportunities for your organization. 
 
The Action bar displays the following options: 
 
Create Contact, Create Contact from vCard, View Contacts and Import Contacts 
 

 

 
 

4.14.1. To Create a Contact 

1. In the Action bar, click Create Contact: 
2. Fill up the following information on the Contacts page: 

 First Name. Key in the contact’s first name. 

 Last Name. Key in the contact’s last name. 

 Title. Key in the contact’s business title. 

 Office Phone. Key in the contact’s work number. 

 Mobile. Key in the contact’s cellular phone number. 

 Fax. Key in the contact’s fax number. 

 Organization Name. Select the organization name related with the contact from the existing lists. 

 Address Information: Enter the main address and other address information. To copy information 
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from one section to the other, you can enter the address information on either one of the sections 
and click the arrow buttons. The system automatically enters the address for you if you select a 
contact from the Contact’s list. However, you can update this information anytime.  

 Email Address: Put in an emails address for the contact and then select Primary. If the address is 
incorrect, select Invalid to specify it. An individual can choose Opted Out to unsubscribe any emails 
campaign sent out to the individual. Click Add Icon to add an additional email address. You can add 
multiple email addresses. 

 Description Information: Enter a brief description for the contact. 

 Reports To. Click Select and select the contact’s supervisor from the Contacts list. 

 Lead Source. From the drop-down list, select the source that generated the lead, such as direct 
mail or trade show. 

 Campaign.  Click Select to select it from the Campaigns list in order to associate it with the contacts 

 Sync to Outlook. Select the box to synchronize this contact data with Outlook after installed 
TamTamCRM Plug-in for Microsoft Outlook 

 Do Not Call. Select this box to put the contact into Do Not Call list to avoid from sent out 
campaigns to this contact. 

 Assigned to. Choose the individual responsible to communicate with this contact. By default, user 
himself/herself assigned to the contact. 

3. Click Save to save the contact; click Cancel to return to the Contact’s home page without creating the new 
contact. 
 

4.14.2. To View and Manage Contacts 

 
- To delete one or more of the listed contacts, use the Mass Update panel. To do this, check off appropriate 

contacts, click Action -> Select Delete. 
- Click on the contact name in the list to show the detail view. 
- To export records, check off the appropriate contacts and click Action ->Select Export.  
- To edit contact details, in the detail view, click Edit. 
- To duplicate contact information, in the detail view, click Duplicate. 
- To track modify made to contact information click the View Change Log link placed below the Edit button. 
- To manage newsletter subscriptions, click Manage Subscriptions. To add the individual to a newsletter 

subscription mailing list, select the newsletter from the Available NewsLetters list and drag it to the 
NewsLetters Subscribed To list and vice versa. Click Save to update the information. 

- To manage records in a sub-panel, see “To manage related information in sub-panels”.  
 

4.14.3. Creating Contacts from vCards  

 
You can also create a new contact in TamTamCRM importing a vCard file from your local file system. 
 
To import a vCard: 
1. In the choose Create Contact from vCard in the Action bar 
2. On click Browse to navigate to the vCard location on the local file system. 
3. In the Choose File dialog box, select the file and click Open. 
4. The file path displays in the Contacts Import vCard field. 
5. Click Import vCard. 
 
See below: 
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The detail in the vCard displays on a new Contacts detail page. 
The system shows a vCard button adjacent to the contact name. Choose this button to open the vCard file and 
update the information: 

 
 
To edit the contact information, click Edit in the Contacts detail page. To duplicate the information, click Duplicate 
in the Contacts detail page. To delete the information, click Delete in the Contacts detail page. 
 

4.15. Opportunities Module 

Use the Opportunities module to create and manage sales opportunities for your organization: 
The Action bar displays the following options: 
Create Opportunity, View Opportunities and Import Opportunities 
 

 
 
Each opportunity must be connected with only one organization and also enable you to associate it with multiple 
leads and contacts. The TamTamCRM Systems’ customized functionality also allows assigning opportunities to 
teams, which helps share the data related to specific opportunities between multiple team members. 
 
To create an opportunity 
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1. In the Opportunity menu , click Create Opportunity: 

 
This form contains only the required fields. You can enter information for optional fields after you save the form. 

2. On the Opportunities page, enter information for the following fields: 

 Opportunity Name. Enter a title for the opportunity. 

 Month Yr Log. Select the specific date of opportunities log. 

 Age of Opportunity.  

 Probability (%). The system determines the rate for this field based on the selected Sales Stage 
value. However, you also can manually change the Probability % rate. 

  Sector. Select the sector from the dropdown list 

 Currency. Select the currency desired from the dropdown list. 

 Quantity. Enter quantity of the opportunities. 

 Type. Specify whether the opportunity is from an existing customer or a potential customer from 
the drop-down list, 

 Campaign. Click Select to associate an opportunity with a campaign from the Campaigns list. 

 Organization Name. Click Select to choose from the list of existing organizations, 

 Expected Close Date. Enter the expected or estimated close date for this particular opportunity.  

 Estimate Billing Date. The expected or estimated billing date for this particular opportunity. 

 Revised Closed Date. The expected or revised close date for this particular opportunity. 

 Sales Stage. The current stage of this opportunity.  

 Lead Source. State the lead source such from the drop-down list. 

 Opportunities Amount. Enter the estimated amount of the closing a sale. 

 Solution. Select the solution for these opportunities. 

 Channel. Enter the channel for these opportunities. 

 H/W product. Enter the h/w product for these opportunities. 

 Next Step. Specify the next step in closing a sale. 

 Assigned to. Enter the name of the individual who is responsible for working on the opportunity. 
To choose an existing user, click Select, and choose the person from the User List. By default, this is 
assigned to you. 

 The value specified for the Sales Stage determines the default value displayed in the Probability 
field on the Opportunity page.  

 Description. Enter a brief explanation of the opportunity.  

 When you are done, click on Save. 
 
Look below for an example of the filled in “Create Opportunity” form: 
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As you click on Save button, the system will take you to the page of the opportunity you have just created. From 
here, you can connect your opportunity to specific Activities, Leads, Contacts, and Documents by clicking on 
appropriate Create or Select buttons: 

 
 
You can learn more about managing related information in sub-panels in “To manage related information in sub-
panels”. 
 
When you make all the necessary changes to your opportunity, the system will take you back onto the 
Opportunities Home page, displaying the list of your opportunities. From here, you can assign your opportunity to 
a specific team to share it with your team members as well. To do it, check off the appropriate opportunity and 
click Action ->Select Mass Update, in the Mass Update box select the necessary team from the drop down list and 
click Update:  
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To manage opportunities 

- Click any column title which has the  38.png icon beside it to sort the list view and click the column title 
again to reverse the sort order. 

- Use the Mass Update sub-panel to edit or delete some or all the listed opportunities. 
- To export records, check off the appropriate opportunity and click Action ->Select Export. 
- Click the opportunity name in the list to view the details of an opportunity,  
- Click Edit to edit the details on the detail page. 
- Click Duplicate on the detail page to duplicate an opportunity 
- Click Delete on the detail page to delete an opportunity 
- To find duplicates an opportunity, on the detail page, clicks Find Duplicates. 
- To track changes to an opportunity over time, click the View Change Log link. 
- To import opportunity data from an external source, see “Importing data”. 
- Click the Merge Duplicates link to merge duplicates and follows the process described in “Merging 

Duplicate Records.” 

4.16. Leads Module 

 

Use the Leads module to create and manage sales leads for your organization:  
The Action bar displays the following options: 
 
Create Lead, Create Lead from vCard, View Leads and Import Leads 
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Leads are potential individual to be contacts according to the opportunity identified in the sales process. After they 
have been evaluated and assessed, you can convert them into Contacts, Opportunities, and Organizations. Lead 
can be associated with any type of Campaign to track the effectiveness and subsequently generating opportunities 
for your organization. 
 
To create a lead 
 
1. In the Lead menu, click Create Leads.  
2. On the Leads page, enter information for the following: 

 First Name. Key in the lead’s first name. 

 Last Name. Key in the lead’s last name. 

 Title. Key in the business title of the lead. 

 Department. Key in the department to which the lead belongs. 

 Organization Name. Enter the name of the organization related to the lead. 

 Office Phone. Enter the lead’s work number. 

 Mobile. Key in the lead’s mobile phone number. 

 Fax. Key in the lead’s fax number 

 Website. Key in the lead’s website. 
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 Primary Address: Street, City, State, Postal Code and Country 

 Other Address: Street, City, State, Postal Code and Country 

 Address Information. Enter the primary address and other address information. To copy the other 
address from the primary address, select the Copy address from left checkbox. 

 Email Address. Enter an emails address, contacts and campaign targets within the organization. If 
an email address is incorrect, select Invalid to specify it. The leads can select Opted Out. To add 
additional email addresses, click Add Address. 

 Lead Source. Select the origins of the lead from the drop-down list. 

 Lead Source Description. Enter a brief explanation of the lead source. 

 Status. From the drop-down list, select the status of the lead such as New or In Process. 

 Status Description. Enter a brief explanation for the lead status. 

 Opportunity Amount. Enter the opportunities amount for these leads.  

 Campaign. To associate the lead with a campaign, click Select to select it from the Campaigns list. 

 Referred by. Enter the information in this field if someone referred the lead to you, 

 Email Opt Out. Select this box if the lead opted to not share their email address with you. 

 Invalid Email. If an email address is invalid, select this box 

 Do Not Call. Check this box to add the lead’s name to the Do Not Call list to avoid the lists from 
targeted during campaigns. 

 Assigned to. Enter the name of the individual who is responsible for the lead. To choose an existing 
user, click Select, and choose the person from the User List. By default, this is assigned to you. 

 Description. Enter a brief explanation for the lead. 
2. Click Save to save the new lead information or click Cancel to return to the Leads home page without 

saving the information. See the example of the completed “Create Lead” form below: 
 

 
 
After you save the lead, the lead’s detail page displays on the screen. You can create activities and view past 
marketing activities including a list of any campaigns that were sent out to the lead. 
Managing Lead Information 
You can manage and track leads through their life-cycle.  
 
To manage leads 

- To search for a lead, use the Search sub-panel on the Leads Home Module as described in “Searching for 
Information on TamTamCRM”. 
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- To export records, check off the appropriate leads and click Action ->Select Export.  
- To merge duplicates, check off the appropriate leads and click Action ->Select Merge and follow the 

process described in “To merge duplicate records”. 
- To find duplicates a lead, on the detail page, clicks Find Duplicates. 
- To track any modification to the lead information over time, click the View Change Log link.  
- To edit or delete information some or all of the leads, check off appropriate leads, click Action -> Delete. 
- To view detail information, click on the lead name from the list.  
- To update information, on the detail page, click Edit. 
- To monitor newsletter subscriptions, on the detail page, click Manage Subscriptions. To add the individual 

to a newsletter subscription mailing list, select the newsletter from the Available Newsletters list and drag 
it to the Newsletters Subscribed To list and vice versa Click Save to update the information. 

- To duplicate a lead, on the detail page, click Duplicate.  
- To delete a lead, on the detail page, click Delete. 
- To convert a lead to a contact, click Convert Lead. Optionally, you can also convert the lead to a related 

Organization, Opportunity, and Appointment. 
- To view and edit associated information in a sub-panel, see “To manage related information in sub-

panels”. 
 
Note:  You can create Web-to-Lead forms for apply in Web-based campaigns and other sources such as your 
Website or blog. This Lead information is saved in the TamTamCRM database and can be used to produce 
opportunities for your organization. For more information, see “Creating Web-to-Lead Forms”. 
 

4.17. Documents Module 

Main purpose of Documents module is to create and manage files that you share with users and contacts. 
 
To create a document: 
 

1. In the Action bar, click Create.  
2. The system will respond with the form to fill in. The fields to fill in include:  

 

 File Name. Enter the title of the file you are using to create the document; click Browse to navigate 
to the location of the document and select the file.  

 Status. From the drop-down list, select the class to indicate the current state of the document  

 Document Name. Enter a name for the document. 

 Revision. Enter the revision number each time you revise the document. 

 Document Type. Select a pre-defined document from the drop-down list 

 Template. Select this box if you are making a template. 

 Publish Date. Click the Calendar icon and select the date when the document is available for other 
users to view and download. 

 Category. Select a pre-defined category from the drop-down list.  

 Sub Category. If you selected a category, select the category subset if applicable. 
When you select a Category and Sub Category for the document, the document will be added 
added to the Document tree using a hierarchical structure. The tree structure only displays in the 
list view and helps organize the files and makes it easier to find documents under a specific 
subject. The values listed in Categories and Sub Categories are defined by the administrator. 

 Expiration Date. Click the Calendar icon and choose the date when the validity of the document 
expires. 

 Related Document. Click Select to relate a related document. 

 Related Document Revision. From the drop-down list, select the revision number of the related 
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document. 

 Description. Enter a brief explanation of the document. 
3. Click Save to create the document or Cancel to return to the document list without saving the document. 
4. Look at the filled in example of “Create Document” herein below: 

 
  

The file will now be displayed in the documents list as well as on the detail page in the Download File field. Click 
the attachment to open or save it to your computer.  
 
To manage documents  

- To sort a list view, click any column title which has the  38.png icon beside it or to reverse the sort 
order, click the column title again. 

- To edit or delete some or all the documents, apply the Mass Update panel. 
- To view the details of a document, on the Documents module, click its name; links to attachments, if any, 

are displayed below Description. 
- Click the attachment link to view an attachment. 
- To update a document, on the detail page, click Edit. 
- To copy a document, on the detail page, click Duplicate. 
- To remove a document, on the detail page, click Delete. 
- To track any modification to the document, click the View Change Log link below the Edit button. 
- To export documents, select in the Document List sub-panel on the Documents Home page, click the 

Export icon, and export them as described in “Exporting Data”. 
 
 
To update an attachment 
 

1.  Click Create in the Document Revisions sub-panel of the document’s detail page:  
 

 
 

2. The Documents Revision page, the current document name and revision number appear on this page.  
3. Put in the related information for the following fields: 

 FileName. Enter the title of the file containing the revised information; to navigate to the file 
location, click Browse. 

 Revision. State a revision number for the revised document. 
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 Change Log. Enter a brief explanation of the revision. 
4. Click Save to save your changes or click Cancel to go back to the document detail page without saving the 

changes. See the example of the filled in form below:  
 

 
 
Name of the attached file can’t be changed and the revised file is displayed along with its revision number in the 
Documents Revisions sub-panel. In this sub-panel, it list all the older document version and displays the rem icon 
to delete the file. To delete the previous version of the attachment, click the rem icon, and click OK to confirm the 
removal: 
 

 

4.18. Email Module 

The Emails module allows you to manage your emails: 
 

 
 
You can use the new Emails module as an email client to manage your inbound and outbound emails. You can send 
the emails that you compose in TamTamCRM through any of your external mail account. 
In addition, the Emails module offers the following features: 

- Ability to create Group folders to route emails for distribution.  
- A default personal folder named My Emails. You can create additional personal folders. 
- Ability to create records such as bugs and leads from inbound emails. 
- Ability to create an address book with entries from your list of users, contacts, and leads. 
- Ability to import emails. You can import emails into TamTamCRM from external mail servers. The Emails 

module provides a folder named My Email for this purpose. You can associate an imported email with a 
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TamTamCRM record such as a bug or an organization. This creates a thread of email communication 
related to that record for future reference. 

 
In addition, you can perform the following actions in the Emails module: 

- Search for emails based on parameters, such as keyword and subject. 
- Create a related record, such as a bug or a lead, from an email. 
- Create an address book consisting of users, contacts, and leads with whom you frequently communicate. 
 

4.18.1. Setting up Your Mail Account 

 
You will need to set up a mail account in TamTamCRM for every external mail account that you want to access 
through TamTamCRM. You must set up at least one mail account in TamTamCRM to be able to send and receive 
emails.  
 
 
 
 
 
 
 
 
To create a mail account 
 

1. Click Settings at the top of the page: 
 

 
 

 
2. Select My Accounts and click Add on the Settings page: 
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3. Enter the following information to create a new mail account: 

 Mail Account Name. Enter a name for the account. 

 User Name. Enter your user name. 

 Password. Enter your user password. 

 Mail Server Address. Enter the address of the email server from which your emails will be routed to 
TamTamCRM. To access a Gmail account, click Prefill Gmail. 

 Default. To auto fill the mail server port number and protocol. 

 Use SSL. Select this box if you are using POP3 and your external mail account requires SSL. 

 Mail Server Protocol. From the drop-down list, select either IMAP or POP3.   
o When you create an account for an external mail account such as Yahoo or Google, you must 

ensure that you are using their mail server protocol.  
o Mail Server Port. The system automatically populates this field with the port number for the 

selected protocol. 
o Monitored Folder. This field only appeared when you select IMAP as the protocol. By default, the 

system monitors the inbox. Click select to view a list of folder for others monitored folders.  
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o Trash Folder. To select a trash folder from the folder record, click Select. After that, click OK.  
o Sent Folder. To add sent folder to view your outbound emails, click select.  After you specify a 

folder, click OK. 
4.  Click test setting to ensure that the setting are correctly configured  
In the Outgoing Email section, put in the following information: 

 From Name. Enter the name of the sender. 

 From Address. Enter the sender’s address. 

 Reply to Address. Enter the sender’s reply address 

 Outgoing SMTP Mail Server. From the drop-down list, select a mail server for outbound emails or 
add new SMTP Mail Server.  

5. Click Done to create the mail account. or cancel without save your information. 
6. Click Clear Form to reset filled data. 
7. To close window, click close 
 
To add a mail server for outbound emails 
 
1.  Click the Add button located next to the Outgoing Mail Server drop-down list: 
 

 
 
The Outbound Mail Server page appeared on the screen.  The Outbound Mail Server Properties page displays on 
the screen. You can choose Gmail, Yahoo, Exchange, or Other.  
 

1. Enter information for the following fields: 

 Name. Enter a name for the account. 

 SMTP Server. Enter the SMTP mail server’s address. 

 SMTP Port. Enter the mail server’s port number. 

 To add Google’s Gmail server, click Set Gmail Defaults. The system fills in the SMTP Server and 
SMTP Port fields with the Gmail server address and port number respectively. 

 Enable SMTP over SSL or TSL. Select this option if you are using the POP3 protocol and the mail 
server requires SSL. 

 Use SMTP Authentication. Select this option if the mail server requires authentication to send out 
the email. 

 SMTP Username. Enter your username for the mail account. 

 SMTP Password. Enter your password for the mail account. 
2. Click done to add the mail server; click Cancel if you do not want to add the mail server. 
3. Click Test Settings to ensure that the settings are correctly configured. 
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See the example of a mail server settings page completed: 
 

 
 
After you have created your email account and added a mail server for outbound mails, you can start working with 
your emails. The procedure of working with Emails Module in TamTamCRM has very much in common with using 
other email clients. 
 

4.18.2. Compose an Email 

1. To compose an Email, on the emails home page, click Compose Email. 

2. To compose an email, enter information for the following fields; 

From. Enter the name of the individual who sent out the email. 
To. Click this button to select recipients from the address book, or manually enter the email address of 
recipients in the field. 
Bcc. Click this button to select recipients from the address book, or manually enter the email address of 
recipients in the field. 
Subject. Enter the topic of the email. 
Attach. Click this button to attach a file that is located on your machine. You can enter the path to the file 
or click Browse to navigate to the file. 
Plain Text. Select this box to display the email in text format if an email client cannot render HTML code. 
Option. To populate the email with the contents of an email template  

3. Click Send to send the email 

 

4.18.3. Creating Email Templates 

 
You can apply email templates to create form letters for automated email responses to inbound emails and for 
mass email campaigns. For instance, when you receive an inbound email regarding a bug or a case, you can send 
out automatic reply stating that the matter will be addressed. 
 
Whereas, for email campaigns, enter the message in the template and then specify the variables such as the target 
names and addresses from the campaign target list. The system inserts these variables into the template in order 
to create a personalized email for every target. You can embed images and attach files from the TamTamCRM 
repository or from your local file system when creating an email template. 
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Besides, you also can insert tracker URLs into the template to track campaign movement. For further information 
on email campaigns, click “Executing an Email Campaign”. 
 
You can use email templates to create automated responses when you receive inbound emails regarding a specific 
topic such as a bug or a case. 
  
To create an email template: 
 
1. In the Action bar, click Create Email Template and you will see the form to fill in: 
 

 
2. Enter information for the following fields: 

 Name. Enter a title for the template. 

 Assigned To. To assign the template to desired user, click the arrow button and select from the list of 
users. 

 Description. Enter a brief explanation about the template. 

 Insert Variable. From the drop-down list, select a record such as contact and select a field such as Full 
Name and then click Insert. The system will show the variable in the Body field.  

3. Insert Tracker URL. This field shows only when you create the template from the email marketing record of an 
Email campaign. Select the tracker URL to insert and click Insert URL Reference from the drop-down list.  
The Body field displays a link named Default link text. The adjacent field displays the tracker name for plain text 
format.  
4. Subject. Enter the subject of the message. 
5. Body. Enter the email content also can embed images and add URL links. To view and apply the HTML editor, 
click HTML in the Body field.  
6. To use standard formatting options such as font face, size, bold, italics, indentation and color, highlight the text 
and select the appropriate option in the Body field. 
7. Send Text only. Select this box to display the email in plain text format and if an email client cannot render 
HTML code.  
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8. Attachments:  
To attach a file, including images, click Browse to navigate to its location on your local machine.  The attached files 
displays below the Browse button.  
9. TamTamCRM Document. Click this button to attach a document from the TamTamCRM repository; when you 
select the file from the Documents List, the system attaches it to the email template. 
10. Click Save to create the template; click Cancel to exit the page without saving your changes. 
  
To manage email templates 
 

- To search for a template, enter the name or description in the Search sub-panel on the Email Templates 
page, and then click Search. 

- To see the details of a template, click the template name from the list on the Email Templates page. 
- To update the template, on the detail page, click Edit, make the changes, and click Save. 
- To copy the template, on the detail page, click Duplicate and click Save. 
- To remove the template, on the detail page, click Delete; to delete some or all the templates, select them 

from the list on the Email Templates Home page, and click Delete. 
- To export one or more templates, select the templates from the list on the Email Templates Home page, 

and then click Export. 
- To deselect templates that you selected in the list, click Clear All. 

 

4.19. Campaigns Module 

Apply the Campaigns Module to track and monitor mass marketing campaigns: 
 

  
 
Normally, a mass marketing campaign targets a large group of individuals or organizations. So, the campaign 
process begins with identifying the targets, and then group multiple targets into a target list according to a set of 
predetermined criteria such as age group or spending habits.  
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4.19.1. Creating and Importing Campaign Targets 

A target is an individual that you have some details on but does not meet the criteria as a lead or contact. Targets 
are separate records that are not attached to contacts, leads, or opportunities. However, you can insert contacts, 
leads, and users to a campaign’s target list.  
You can add targets to a target list by importing them from a file (either CSV or TSV) or by selecting them from 
existing contacts and leads. For information on importing targets, see “Importing Data”. 
Usually, user can create or import a target list first, associate it with targets, and then associate it with a campaign. 
However, user can also create a campaign first and then associate it with a target list.  
The general practice is as follows: 

  
 
A target list can specify either individual who needs to be included or excluded from a campaign. 
 
To create a target list 
 
1. From the Actions bar on the Campaigns Module, click Create Target List. 
2. On the Target Lists page, insert the following information: 

Name. Enter a title for the target list. 
Type. From the drop-down list, select the type of the target list:  

 Default. A list of people who are the campaign targets and accept the campaign email. 

 Seed. A list of people who need to receive the campaign email but must not be followed as 
potential leads. Usually, these are individuals who need to approve the campaign before it is 
launched. 

 Test. A list of people who receive the campaign email to test how different email clients appear 
in the campaign message before you send it out to the default list.  

 Suppression List. A list of people to be excluded from the campaign email recipient list. Normally, 
these are people who chose to opt out of receiving your campaign message.  

 Assigned to. Enter the name of the user assigned to this list; click Select to select from the User 
list. By default, it is assigned to you. 

Description. Enter a brief description of the target list. 
3. Click Save to save the target list or Cancel to exit the page without creating the list. 
 
To create a target 
1. In the Action bar, click Create Target.  
Note:  Targets are separate records that are not attached to Contacts or Leads. If you plan to send emails to 
existing Contacts or Leads, you can leave out the step below. 
2. On the Targets page, enter information for the following fields: 

 First Name. Key in the target’s first name. 

 Last Name. Key in the target’s last name. 

 Office Phone. Enter the target’s offive number. 

 Mobile. Key in the target’s mobile phone number. 

 Fax. Key in the target’s fax number. 

 Title. Enter the target’s title. 

 Department. Insert the name of the department to which the target belongs to. 

 Organization Name. Enter the name of the organization connected to the target. 

 Do Not Call. Select this box to add the target’s name to the Do Not Call list. 

 Assigned to. Select the user who is responsible to the target. 

 Email Address. Enter one or more email addresses for the contact and select Primary. If an email 



  
Title: TamTamCRM User Manual 

 
 
 
 

Confidential 

   

 

 

 Page: 57/77 

© TAMTAMCRM, 2012 
 

address is incorrect, select Invalid to indicate it. Individual can choose Opted Out to opt out from 
the campaign.To add additional email addresses, click Add Address. 

 Address Information. Enter the primary address and other address information. To copy 
information from one section to the other, you can enter the address information and click the 
arrow buttons. 

 Description. Enter a brief explanation of the target. 
3. Click Save to create the target or Cancel to exit the page without creating the target. 
See an example of the completed “Create Target” form below: 

 
 
After saved the target, the target’s detail page displays the Campaign Log sub-panel which lists all the campaigns 
sent to the target. 
 

4.19.2. Creating a Campaign 

You can create a campaign using the Campaign Classic or the Campaign Wizard option. Campaign Classic option 
allows you to create campaign record but you are not completing related tasks such as specifying the email 
settings. For more information on creating a campaign using the Classic option, see “Creating a Campaign”.  
 
Whereas for the Campaign Wizard, it guides you through the process of creating the campaign as well as 
completing related tasks. For more details on creating a campaign with the Campaign Wizard, see “Using the 
Campaign Wizard”. 
 
The Campaigns module gives an embedded Return on Investment (ROI) form that with purpose to gauge the 
success of an executed campaign. For more information, see “Viewing a Campaign’s Return on Investment”. 
 
 
 
Types of Campaigns 
You can create many kinds of marketing campaigns such as Email, Newsletter, Mail, Web, Radio, Television, Print, 
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and Telesales. A campaign such as Mail and Radio allows you to record it in TamTamCRM for your reference but 
cannot execute the campaign through TamTamCRM. Only Email campaign or a Newsletter campaign can be 
executed through TamTamCRM. In an Email campaign, you send out a one-time email with the information that is 
of interest to your targets. In a newsletter campaign, you email a newsletter to your targets on a regular basis. For 
example, a newsletter can include information on product updates. You can send out a newsletter on a weekly, 
monthly, quarterly, or yearly basis. To determine the campaign’s success, you can view statistics such as the 
number of targets that responded the number of opportunities that were created, and the generated revenue.  
 
The status of the launched Email or Newsletter campaign can be review to know the success. For instance, you can 
view how many targets viewed the campaign email, how many clicked any links that were included in the email, 
and how many leads and contacts were created from the campaign. For further information, see “Managing 
Campaigns”. 
 
To capture leads from an email or a newsletter campaign, you also can create a Web-to-Lead form. For more 
information, see “Creating Web-to-Lead Forms”. 
 
In addition, for Email campaigns, you can insert images in your email templates instead of sending them as 
attachments. This avoids your emails from being reported as spam. For more information on embedding images, 
see “Creating Email Templates”. 
 
A campaign diagnostic tool is provided to help you ensure that all pending administrative tasks, such as setting up 
a bounce-handling inbox, have been finished. For more information, see “Using the Campaign Wizard”. 
Note:  You must be an administrator to use the Email Setup option that showss in the Action bar. 
 
To create a campaign (Classic) 
1.  Select Create Campaign (Classic) from the action bar.  
2.  Insert information for the following fields: 

 Name. Enter the campaign title. 

 Status. From the drop-down list, select the current status of the campaign.  

 Start Date. Click the Calendar icon and select the date on which the campaign starts. 

 End Date. Click the Calendar icon and select the date on which the campaign finished. 

 Type. From the drop-down list, select the campaign type. For further information on email campaigns, see 
“Executing an Email Campaign”. 

 Currency. From the drop-down list, select the currency used to state the budget, cost, and revenue. 

 Assigned to. Enter the name of the user assigned to the campaign; to choose a user from the Users list, 
click Select, and click the user name. 

o Note: The Start Date, Finish Date, and Status values are for own records only. These values do 
not impact the execution of an email marketing campaign. 

 Impressions. Enter the number of page impressions generated from the campaign. You will need to fill in 
this field after the campaign has begun. 

 Budget. Enter the budget provide for the campaign. 

 Actual Cost. Enter the actual cost incurred to carry out the campaign. 

 Expected Revenue. Enter the expected revenue from the campaign. 

 Expected Cost. Enter the expected cost of the campaign. 

 Objective. Explain the aim of the campaign. 

 Description. Enter a brief explanation of the campaign. 
 
 
 
See an example of the completed “Create a Campaign” form below: 
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3.  Click Save to save the campaign or Cancel to return to the Campaigns home page without creating the 
campaign. 
 
After you click on Save, the system displays the campaign’s detail page. The detail page of an email campaign or a 
newsletter campaign displays sub-panels for targets, tracker URLs, and email marketing. You can create and view 
any of this information from the respective sub-panels.  
 

4.19.3. Executing an Email Campaign 

 
The process of executing an email campaign consists of the following steps: 
1. Create an email campaign as described in “To create a campaign”. On the other hand, you can use the campaign 
wizard to create the campaign as described in “Using the Campaign Wizard”. The Campaign wizard will lead you 
through the steps listed below. 
2. Identify the targets as described in “Creating and Importing Campaign Targets”. You can import targets, or 
create a new target list, or merge with existing target list. You can also select individuals from a lead report or a 
contact report. 
3. Create an email template including the message you want to convey to your targets. For more information, see 
“Creating Email Templates”.  
4. Specify an inbox for bounce-handling. This is required to handle campaign emails that bounce back to you. Only 
administrators can set up mailboxes for inbound emails. When you create a bounce-handling inbox, all bounced 
campaign emails are routed to that inbox. Bounced emails contain specific identifiers that enable you to tell them 
apart from emails that are responses from your targets.  
5. Create email marketing records that indicate information such as the target list, the email template, the 
campaign start date, and the bounce-handling inbox. For more information, see “Creating Email Marketing 
Records”. 
6. Optionally, specify one or more Tracker Redirect URLs to follow up campaign activities. For more information, 
see “To create a tracker redirect URL”. 
7. Optionally, run the diagnostic tool to make sure that the email campaign will be successfully executed. For more 
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information, see “Running Campaign Diagnostics”. 
8. Send a test email to your test list to ensure the operation is successful. For more information on test lists, see 
“Creating and Importing Campaign Targets”. 
9. Clear statistics from the test email. 
10. Ask for the administrator to schedule a job to send out the campaign emails. 
11.  Queue the email for the campaign launch. 
12. Besides, you also can convert the campaign targets into leads or contacts. 
 
You can connect a Web-to-Lead form with the campaign. For more information, see “Creating Web-to-Lead 
Forms”. After you commence an email campaign, you can view the campaign status for information on the 
campaign results. For more information, see “Viewing Campaign Status”. 
Note:  The start date, start time, and status specified on the email marketing page determine when the email is 
sent. 
 

4.19.4. Creating Email Marketing Records 

When you create an email campaign, you must also create an email marketing record that including information 
such as the campaign target list, the campaign email template, and the inbox to handle emails that bounce back to 
you. You must specify the email marketing start date and time that is in the past to queue it for delivery. Any 
emails that rebound are sent to the “From Address” defined in this record. 
 
To create an email marketing record 
 
1. On the campaign’s detail page, scroll down to the Email Marketing sub-panel and click Create: 

 
 
 
2. On the Email Marketing page, insert information for the following fields: 
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 Name. Key in a name for the record. 

 Status. From the drop-down list, select Active if the record is in use or Inactive if the record is not in use. 
Only active records will be queued for campaign launch. 

 Use Mailbox. From the drop-down list, choose a mailbox that is set up for Bounce Handling. 

 From Name. Key in the name of the organization or person that is sending out the email. 

 Start Date & Time. Click the Calendar icon and select a date to send out the email. Enter the time in the 
adjacent field.  

o Note: To queue the email for campaign launch, select a date and time that has already passed. 
You be supposed to do this after you ensure that the test email was successful. 

 Email Template. From the drop-down list, select an existing email template; to create a new template or 
edit an existing one, click the adjoining Create or Edit link respectively.  

 You need to edit the template to add the Tracker URLs described below into Text and HTML formats. 

 Send This Message to. Select target lists from the box below and to send it to all the target lists in the 
box, select the All Target Lists in the Campaign box. 

 
See an example of the completed “Create email marketing record” form below: 
 

 
3. To save the record, click Save or Cancel to exit the page without saving your changes. 
 

4.19.5. Creating Tracker Redirect URLs 

You can use URLs in your campaign emails to track the answer to your campaign. The system generates a unique 
key for each URL and for each recipient and associates it with the email template. When recipients open the email 
and click on a URL link, the system can track each action by each recipient.  
 
Note:  You are supposed to check with your system administrator to ensure that the outbound email process is 
configured to send email from your system as described in Configure System section and Mass Emailing section. 
 
To create a tracker redirect URL 
1. On the Campaign’s detail page, scroll down to the Tracker URLs sub-panel, and click Create.  
2. On the Campaign Trackers page, enter information for the following fields: 

 Tracker Name. Enter a tracker name for your reference by using alpha-numeric characters. 

 Tracker URL. Enter the tracker URL such as http://www.tamtamcrm.com/trial. 

 Opt-out Link? Select this box to embed your “Unsubscribe” instructions in a tracker URL. By default, the 
system uses the removeme.php file which contains these instructions, and displays this file name in the 
Tracker URL field. 

See an example of the completed field below: 
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3.  To create the campaign tracker, click Save or Cancel to exit the page without saving your changes. 
 

4.19.6. Using the Campaign Wizard 

You can use the campaign wizard to guide you through the process of completing a campaign.  
1. In the Actions bar of the Campaigns module, click Campaign Wizard. 
The Campaign wizard appears on the screen. 
2. Select the type of campaign you want to create and click Start. The screen below illustrates a Newsletter 
campaign: 

 
3. Enter information for the following fields: 

Name. Enter the campaign name. 
Status. From the drop-down list, select the current state of the campaign. 
Assigned to. Enter the name of the user who is assigned to the campaign. To select from the Users list, click 
Select. By default, it is assigned to you. 
Type. If you are creating a non-email campaign, select the campaign type from the drop-down list. 
Frequency. From the drop-down list, select the intervals at which the newsletter will be emailed to targets. 
Start Date. Click the Calendar icon to select the date to enter the campaign start date. 
End Date. Enter the campaign end date; click the Calendar icon to select the date. 
Description. Optionally, enter a brief description of the campaign.  

 
Click Next. See below: 
 

 
4.  A Click on Next takes you to the campaign budget information page. Enter information for the following fields: 
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 Budget. Enter the campaign budget. 

 Actual Cost. Enter the actual cost of the campaign. 

 Expected Cost. Enter the expected cost of the campaign. 

 Expected Revenue. Enter the estimated revenue from the campaign. 

 Currency. From the drop-down list, select the currency used for the campaign. 
See below for an example of the completed form: 
 

 
 
5. Click Next. On the “Campaign Tracker URLs” page, enter information for the following fields: 

Tracker Name. Enter a tracker name. 
Opt-out link? Select this box to create an opt-out tracker that allows targets to unsubscribe from your email 
campaigns. 
Tracker URL. Enter the tracker URL. For more information, see “Creating Tracker Redirect URLs”. 

6. Click Create Tracker. The new tracker displays below. To create additional tracker URLs, click Create Tracker 
again and enter the new tracker information. 
 
See an example of the completed form below: 
 

 
 
7. Click Next. 
If you want to create an email campaign or a non-email campaign, the Target Lists screen displays on the screen.  If 
you are creating a newsletter campaign, the Subscription Information page displays, as in our case: 
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a.      Click Select and use the Search panel to find the list to use an existing target list, 
b.       Enter the Target List Name field and select the type from the adjoining Target List Type field to create a new 
target list. The target list name displays below.  
8.       For newsletters, you must create the following three subscription lists: 

Subscription list: These targets receive the newsletter regularly. 
Unsubscription list: These targets are those who have chosen to opt-out of your mailing list. 
Test list: These targets are the recipients of the test email that you send out to ensure it is successful. 

9.  To save the campaign information and begin the process of specifying other details such as the email settings, 
click Save and Continue. If you want specify the email settings later, click Finish. 
 
When you click Save and Continue, the Marketing Email page displays on the screen: 
 

 
 
For more information, see “Creating Email Marketing Records”. 
When you click on Finish, the campaigns detail page displays on the screen.   
 

4.19.7. Running Campaign Diagnostics 

Executing an email campaign or a newsletter campaign involves several steps, some of which can be performed 
only by administrator.  
 
To run diagnostics 



  
Title: TamTamCRM User Manual 

 
 
 
 

Confidential 

   

 

 

 Page: 65/77 

© TAMTAMCRM, 2012 
 

1. In the Action menu of the Campaigns module, click View Diagnostics. 
The Campaign Diagnostics page displays on the screen: 
 

 
If the email settings and a bounce-handling inbox have not been configured, warning messages display on this 
page. Contact the administrator to complete these tasks. 
2. To perform the diagnostics again, click Re-Check. 
 

4.19.8. Testing Campaigns 

 
Before lunch an email or newsletter campaign, it is recommended that you test it check how different email clients 
display the campaign message. To test a campaign click Send Test and on the Campaign’s detail page, select the 
message, and click Send. Ensure that you are sending out the campaign to the Test target list. 
 

4.19.9. Managing Campaigns  

 
To manage campaign:. 

- To sort the list view, on the Campaigns Home page, click any column title which has the  icon beside it; 
to reverse the sort order, click the column title again.  

- To update information for some or all campaigns, on the Campaigns home page, use the Mass Update 
panel. 

- To view the campaign’s details, click the campaign name on the list. From the detail page, you can create 
Tracker URLs and Email Marketing Records for email campaigns. For more information on email 
campaigns, see “Executing an Email Campaign”. 

- To edit the campaign information, on the detail page, click Edit. 
- To duplicate the campaign information, on the detail page, click Duplicate. 
- After you launch non-email campaign such as a Telesales or a Mail campaign, you will need to manually 

mark the campaign as “sent”. To do this, click Mark as Sent on the campaign’s detail page. When you click 
this button, the Campaigns sub-panel on a targets' detail page indicates the Activity Type as “Message 
Sent” to indicate that the campaign material was sent to that individual. 

- To delete a campaign, on the detail page, click the Delete. 
- To send an email campaign to the test group before the formal launch, click Send Test. 
- To queue email campaigns for the launch, click Send Emails. 
- To send out the campaign message to the target audience, click Send, and on the Campaign Send page, 

select the message and click Send. 
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- To view the campaign status, see “Viewing Campaign Status”.  
- To track changes to a campaign over time, in the detail view, click the View Change Log link. 
- To export information on one or more campaigns, select them in the Campaign List sub-panel on the 

Campaigns Home page, click the Export icon, and export them as described in “Exporting Data”. 
- To view or manage related records in a sub-panel, see “To manage related information in sub-panels”. 

 

4.19.10. Viewing Campaign Status 

After execute a campaign, you can view the campaign status to determine its success. From a campaign’s detail 
page, you can view the status and the result of the campaign such as the number of generated leads and the 
return on investment (ROI).  
 

 
 
 The sub-panels on the View display the following information: 

- A chart depicting the responses from campaign targets. This includes how many targets viewed the 
message, how many opened any links that were included in the campaign email, and how many opted out 
of the campaign. 

- A list of any campaign emails are still in the queue to be sent out. 
- A list of processed campaign emails. 
- A list of targets who viewed the campaign email. 
- A list of targets who viewed any links that were included in the campaign email. 
- A list of leads that were created as a result of the campaign. These leads are created when targets identify 

the campaign and, as a result, are converted into leads. 
- A list of contacts that were created as a result of the campaign. These contacts are created when leads 

identify the campaign and, as a result, are converted into contacts. 
- A list of campaign emails that bounced back because of invalid email addresses. Note that this 

information is tracked only if your administrator has scheduled a job to track bounced emails. 
- A list of campaign emails that bounced back for other reasons. 
- A list of targets that opted out of the campaign. 
- A list of opportunities that were generated from the campaign. 

 
 
To view campaign status 
 
1. To view a campaign’s statistics, click the View Status link located below the Print icon on the Campaign detail 
page. 
 
The system displays the campaign’s status: 
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4.19.11. Viewing a Campaign’s Return on Investment  

TamTamCRM provides an embedded ROI report based on the “Closed/Won” opportunities generated from the 
campaign. View this report from the campaign’s detail page. 
 
To view a campaign ROI report 
1. On the campaign’s detail page, click the View ROI to view ROI report. 
The ROI chart displays on the screen: 
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This bar chart displays the revenue versus the expected revenue generated from the campaign, as well as the 
actual cost of running the campaign versus the budget allocated for the campaign. 
 

4.19.12. Creating Web-to-Lead Forms 

Use this function to create a Web-to-Lead form. Use this lead information to generate more opportunities for your 
organization. 
You can view and edit generated forms in the FCKEditor. To add new fields to the form, the administrator must 
first create new fields for the Leads module in Studio so that users can select them when they create the form. 
 
To create a lead form 
1. In the Action bar of the Campaigns module, click Create Lead Form. 
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2. Click and drag the desired fields from the Available Fields list to the First Column or the Second Column list. To 
move all the fields, click Add All Fields. 
3. Click Next. 
The Form Properties page displays on the page: 
 

  
4. Enter information for the following fields: 

 Form header. The default header will be displays. You can delete and enter the desired header 
information. 

 Form description. Enter a brief description of the form. 

 Submit button label. The default label displays on the page.  

 Post URL. The default location where the lead information will be stored displays on the page. 
Redirect URL. Enter the redirect URL. For more information, see “Creating Tracker Redirect URLs”. 

 Related campaign. Enter the name of the campaign.  

 Assigned to. Enter the name of the user who is assigned to this form. To select from the Users list, 
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click Select.  

 Form footer. Enter the form footer (if applicable). 
5.  Click Generate Form to create a form. 
 
The system generates the form and displays it on the FCK editor: 
 

 
 
You can edit the form in this editor, if needed. 
6. To save the form, click Save Web to Lead Form. The system saves it on your TamTamCRM server in the 
cache/generated_forms folder.  
 

4.20. Projects Module 

Use the Project Module to create, manage, and duplicate projects and project task. 

To create a project; 

1. In the Action bar, click Create Project. 
2. On the project page, enter the following fields: 

a. Name. Enter a name for the project.  
b. Status. Select the project status 
c. Start Date. Click the calendar icon and select the project start date 
d. End Date. Click the calendar icon and select the project end date. 
e. Assigned To. Enter the name of the user who has ownership of the project. By default, it is 

assigned to you.  
f. Priority. Select the importance of the project.  
g. Description. Enter a brief description of the project. 

3.  Click Save to create a project, Click Cancel to exit the page without creating the project. 
4. Look at the example of filled in “Create Project” from below 
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To create a project task; 

1. In the Project Task Sub-panel, click Create. 
2. On the project task page, enter the following fields: 

a. Name. Enter a name for the project.  
b. Task ID. Enter a numerical value as the task identification number  
c. Start Date. Click the calendar icon and select the task start date 
d. Finish Date. Click the calendar icon and select the task finish date. 
e. Assigned To. Select user to assign these task. 
f. Status. Select the status from the dropdown list 
g. Task Number. Enter the task number  
h. Order. Enter the order number for this task    
i. Estimated Effort (hrs). Enter the expected or estimated effort for this task. 
j. Utilization. Select the utilization from the dropdown list 
k. Percentage Complete. Enter the percentage of the task which has been completed. 
l. Milestone. Check this book if the completion on this task is considered a milestone for project 

completion.  
m. Project Name. Choose the project associated with the task 
n. Priority. Select the importance of the completing this task.  
o. Description. Enter a brief description of the project task. 
 

3. Click Save to create a project task, Click Cancel to exit the page without creating the project task. 
4. Look at the example of filled in “Create Project Task” from below 
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To manage a project 
 
 

1. To update or delete some or all the projects on the Projects Home page, use the Mass Update panel on drop 
down action list. 
2. To view the details of a project, click its name in the list view. 
3. To edit the project details, click Edit on the project’s detail page, make the necessary changes, and 

click Save. 

 

5. Importing and Exporting Data 

In this chapter, we will discuss the problem of importing the data to TamTamCRM and exporting data from 
TamTamCRM . 

5.1. Importing Data 

 
You can import data from Excel files, systems, and Contact Managers into TamTamCRM. When you import data, 
you will need to map fields that you are importing with fields that exist in the TamTamCRM database. For example, 
to map the first and last names of contacts that you import into TamTamCRM, these fields must exist in the 
TamTamCRM database. If not, you will need to create these custom fields in TamTamCRM before you import the 
data. You can import the following: 

- Organizations: ACT! 2005, custom comma delimited files, and custom tab delimited files. 
- Contacts: Microsoft Outlook, ACT! 2005, custom comma delimited files, and custom tab delimited files. 
- Leads: comma delimited files, custom delimited files, and custom tab delimited files. 
- Opportunities: comma delimited files, tab delimited files, and custom delimited files. 
- Targets: Custom comma delimited files, tab delimited files, and custom tab delimited files.  
- Notes: comma delimited files, tab delimited files, and custom tab delimited files. 

 
To import data from your previous application or Contact Manager, you must first export the data from that 
application in a Comma Separated Values (.csv) file format to your local file system. You can then use the import 
function within a specific module to import the CSV file data into TamTamCRM. 
 
Organizations and Contacts 
 
If you import a contact record that refers to an unidentified organization, then a new contact record is 
automatically created. Note that when organization records are created automatically in this fashion, they are 
empty. Which means they have associated contacts but no address or telephone information. Therefore, you will 
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need to manually add that info later. So, it is recommended that you import the organization data first to create 
complete records. If you are importing organization data from another system, then, typically, that system 
understands the distinction between a contact and an organization – that one organization can have multiple 
contacts – and has separate data for each.  
 
Leads and Opportunities  
Typically, only full system, such as Salesforce.com track leads and opportunities. 
  
Targets 
Targets, used in marketing campaigns, are stand-alone records that are not attached to contacts or leads. 
However, you can include contact, lead, and user records in a target list. 
 
Notes 
You can import notes related to a specific call, meeting, or task for distribution to participants.  
 
To export contacts from your current contact manager 
The process below describes exporting contact information through Outlook 2003. Other systems tend to work in 
similar ways: 
 
1. Under the File menu, select Import and Export.  
The Import and Export Wizard dialog box displays on the page.  
2. Choose Export to a file and click Next. 
3. Choose the option to create a file of the type Comma Separated Values (Windows), and click Next. 
4. Choose an Outlook folder from which to export – typically your contacts folder - and click Next. 
5. Insert the filename and directory location for the exported file to be created, and click Next. 
6. To confirm your intention to export this file, click Finish.  
Outlook 2003 creates a CSV file. To make sure that the data has been exported successfully, you can view the file 
using Microsoft Excel or a text editor. 
 
During import, make sure that you correctly map the names of the incoming fields with the names of the 
corresponding TamTamCRM fields. If you are importing from Outlook, a particularly important field mapping is the 
incoming Company field to the Organization Name field within TamTamCRM. This is necessary to ensure that 
contacts are associated with the correct organizations.  
 
 
To import data 
1. In the Action bar of the module’s home page, click Import: 

 
 
2. The first step in the import process displays on the screen. Select one of the following as the data source: 

Microsoft Outlook. This option is available only for TamTamCRM modules that are mapped to a 
corresponding module in Outlook. Select this option if the data file is located in Microsoft Outlook. 
Act!2005. This option is available only for TamTamCRM modules that are mapped to a corresponding 
module in ACT. Select this option if the data file is located in the Act! 2005 database. 
Comma Delimited File. Select this option if the data file is in .csv format.  
Tab Delimited File. Select this option if the data file is in a tab delimited format. 
Custom Delimited File. Select this option if the data file is in TSV format. 
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Click Next to proceed to the next step in the import process: 
 

 
    
3. You must now upload the file that you saved on your local file system. In the Select file field, enter the path to 
the file location; or click Browse to navigate to the file location on your machine. If the file has a header row, check 
the Has Header box. Typically, a header row contains column titles such as Name and Address. Click on Next to 
proceed to the final step in the import process: 
 

 
 
4. You must now map the fields from the export file to the fields in the TamTamCRM database to successfully 
import the data. From the Database Field drop-down list, select the appropriate field in the note, such as Full 
Name and map it to the row in the imported source file. If you want to ignore a field, select Do not map this field. 
To save the mapping as a custom mapping that you can use repeatedly, select the Save as Custom Mapping 
checkbox. To check indexes for duplicate values for fields such as Deleted, and Assigned users, move the desired 
indexes from the Index(es) Not Used column to the Index(es) Used column using the left arrow button. To remove 
an index that you do not want to check, use the right arrow to move it back to the Index (es) Not Used column. Use 
the up and down arrows to sort the order in which the indexes are checked for duplicates. Click Import Now to 
import the data: 
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The Import Results page lists the imported data and lists how many fields were successfully imported and how 
many were skipped. 
  
5. To import additional data, click Import More. 
6. To end the task, click Finished. 
7. If you do not want to save the imported data, click Undo Last Import; You can click Try Again to restart the 
import process. 
 
To import organization data 
If you are importing organization data from a system, proceed to step 4. If you export contact data, and need to 
massage it to act as organization data to be imported, perform steps 1-4 below: 

1. Copy your exported contacts.csv file and save it as Organizations.csv. 
2. Edit the Organizations.csv file using Excel. First, sort the file on the column which contains the company name.  
To avoid multiple copies of the same organization within TamTamCRM, you need to delete the duplicate 
contacts. And to make sure that the most complete information is attached to the organization record, retain 
only the contact whose address and telephone information best represents the organization as a whole.  
Also look out for company names which are similar but not identical due to inconsistencies in the way the 
company name was entered – you should delete all duplicate records except the one with the company name 
spelt exactly how you want to see it in TamTamCRM. 

3. Save the Excel file as a .csv file type. 
4. In the Actions bar of the Organizations module, click Import and follow the process described in “Importing 
Data”. 
Now that organization data has been imported, you can export contacts from your current Contact Manager and 
then import it into TamTamCRM. 
 

5.2. Exporting Data 

You can export item records in .csv format to your hard drive. You may use Microsoft Excel, Notepad, or other text 
editors to open .csv files. You can export selected records, all records on the page, or the entire list. 
A sample portion of a CSV file, exported from the Organizations module and viewed in Excel, is shown in below.  

 
  
To export data from TamTamCRM 
 
1. Select or tick the records from the List View on the module’s home page. 
2. Select Export from the Actions drop-down menu in the List View. 
3. To export all records, click Select located above the item list and select one of the following options: 

 This Page. This function is to export all the records listed on the page. 

 All Records. This function is to export all records on the list. 

4. The system will display an “Opening.csv” dialog box . 
5. Click Open to open the export file in .csv format or click Save to Disk to save the .csv file to your hard 

drive. 
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6. Click OK to execute the operation. If you chose to open the file, the csv file opens in Microsoft Excel. 
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https://www.sugarcrm.com/network/help/OS/6.1/Application_Guides/Sugar_Community_Edition_Application_Gu
ide_6.1.0/Sugar_CommunityEdition_Application_Guide_6.1.0.pdf 
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